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Important Information

Warranty
The AT-FBUS and PCMCIA-FBUS hardware are warranted against defects in materials and workmanship for a period of
one year from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its
option, repair or replace equipment that proves to be defective during the warranty period. This warranty includes parts and
labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability
of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any
action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein
does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National
Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse,
misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

Trademarks
NI-FBUS™ and natinst.com™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical or
clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the user
or application designer. Any use or application of National Instruments products for or involving medical or clinical
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always
continue to be used when National Instruments products are being used. National Instruments products are NOT intended
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health
and safety in medical or clinical treatment.



FCC/DOC Radio Frequency
Interference Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict
accordance with the instructions in this manual, may cause interference to radio and television reception.
Classification requirements are the same for the Federal Communications Commission (FCC) and the
Canadian Department of Communications (DOC). The FCC/DOC classification is indicated on a label on
the devices. Look at the product to determine if your equipment has been tested and found to comply with
Class A or Class B, then read the appropriate information below regarding the compliance of your
product:

Class A
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.

Class B
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.



FCC Notices to User
Changes or modifications not expressly approved by National Instruments could void the user’s
authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of suitable quality
and construction. National Instruments used such cables to test this device and provides them for sale
to the user. The use of inferior or nonshielded interface cables could void the user's authority to
operate the equipment under the FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.
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About
This

Manual

This manual describes the NI-FBUS Monitor utility, its features, and how
to install and use it. The NI-FBUS Monitor utility is intended for use with
Windows 95 or Windows NT.

This manual assumes that you are already familiar with the Windows 95
or Windows NT operating systems.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, contains an overview of the
NI-FBUS Monitor.

• Chapter 2, Installation and Configuration, contains instructions for
installing and configuring your NI-FBUS Monitor software and your
fieldbus interface.

• Chapter 3, Windows and Menus, describes each of the menus and
windows in the NI-FBUS Monitor utility.

• Chapter 4, How to Use the NI-FBUS Monitor, describes how to
perform basic tasks with the NI-FBUS Monitor.

• Appendix A, Hardware Specifications, describes the electrical,
physical, and environmental characteristics of the AT-FBUS and
PCMCIA-FBUS hardware and the recommended operating
conditions.

• Appendix B, Pinout Information, contains information about the
pinout of the fieldbus connectors.

• Appendix C, Customer Communication, contains forms you can use
to request help from National Instruments or to comment on our
products and manuals.
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• The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric
prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in this
manual, including the page where you can find each one.

Conventions Used in This Manual
The following conventions are used in this manual.

» The » symbol leads you through nested menu items and dialog box
options to a final action. The sequence File»Page Setup»Options»
Substitute Fonts directs you to pull down the File menu, select the
Page Setup item, select Options, and finally select the Substitute Fonts
options from the last dialog box.

bold Bold text denotes the names of menus, menu items, parameters, dialog
boxes, dialog box buttons or options, icons, windows, Windows 95 tabs,
or LEDs.

bold italic Bold italic text denotes a note, caution, or warning.

bold monospace Bold text in this font denotes the messages and responses that the
computer automatically prints to the screen.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key
concept. This font also denotes text for which you supply the appropriate
word or value.

italic monospace Italic text in this font denotes that you must supply the appropriate words
or values in the place of these items.

monospace Text in this font denotes text or characters that you should literally enter
from the keyboard, sections of code, programming examples, and syntax
examples. This font is also used for the proper names of disk drives,
paths, directories, programs, subprograms, subroutines, device names,
functions, operations, variables, filenames and extensions, and for
statements and comments taken from programs.

NI-FBUS In this manual, the term NI-FBUS, when used alone, refers to the
NI-FBUS Communications Manager.
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Related Documentation
The following document contains information that you may find helpful
as you read this manual:

• Fieldbus Standard for Use in Industrial Control Systems, Part 2,
ISA-S50.02.1992

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with our
products, and we want to help if you have problems with them. To
make it easy for you to contact us, this manual contains comment and
configuration forms for you to complete. These forms are in the
appendix C, Customer Communication, at the end of this manual.
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Introduction
1

Chapter

This chapter contains an overview of the NI-FBUS Monitor.

NI-FBUS Monitor Overview
The NI-FBUS Monitor is a Win32 application you can use to monitor,
debug, and analyze fieldbus data packets. The NI-FBUS Monitor detects
communication on the bus, capturing data packets that are passed
between fieldbus devices. These packets are time-stamped and displayed
in real time on the NI-FBUS Monitor’s active packet view. The NI-FBUS
Monitor can display data packets in decoded format or in hexadecimal
format. The NI-FBUS Monitor can filter out unwanted data packets at
three levels:  the Fieldbus Data Link layer (FDL), the Fieldbus Messaging
Specification layer (FMS), and by fieldbus addresses.

Windows of the NI-FBUS Monitor
The NI-FBUS Monitor has a Multiple Document Interface (MDI). An
MDI window contains many smaller windows open concurrently that
display data from different sources. These smaller windows are called
filter windows. In the NI-FBUS Monitor, some filter windows might
contain previously-captured data, while other filter windows might
capture new data from different buses or the same bus.

Chapter 3, Windows and Menus, lists and describes the windows of the
NI-FBUS Monitor.
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Recommended Minimum Platform
The NI-FBUS Monitor uses a lot of processor time and memory
resources during data captures. Therefore, the recommended minimum
platform for the NI-FBUS Monitor is a 66 MHz 486 processor with 8 MB
of RAM. If you want to run the NI-FBUS Monitor on a slower platform,
see the Improving Performance section in Chapter 4, How to Use the
NI-FBUS Monitor.
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Installation and
Configuration

2
Chapter

This chapter contains instructions for installing and configuring your
NI-FBUS Monitor software and your fieldbus interface.

Install the Software
Complete the following steps to run the software installation program:

1. Insert the NI-FBUS Monitor software distribution disk into an
unused drive.

2. Choose Run... from the File menu in the Program Manager
window and type the following command into the dialog box:

x:\setup

where x  is the letter of the drive containing the distribution disk
(usually a or b).

The interactive setup program takes you through the necessary steps
to install the software.

Continue to the next section to install the hardware.

Install the Hardware

Warning: Before you remove the card or board from the package, touch the
antistatic plastic package to a metal part of your system chassis to
discharge electrostatic energy, which can damage several components on
your fieldbus interface.
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Evaluating the Default Settings
Skip this section if you are using a PCMCIA-FBUS card and
Windows 95.

Table 2-1 shows the default settings for the AT-FBUS board and the
default resources the NI-FBUS software uses for PCMCIA-FBUS cards.

Table 2-1.  Default Settings

Type of Setting Default

Memory Base Address (hex) D0000 (physical)

Interrupt Line (IRQ) 11

The default settings are suitable for most computer systems. However, if
these default settings conflict with another device in your system, or if
you need to install more than one fieldbus interface, you must change the
default settings before you install the interface.

If you have to change the settings, continue to the following sections to
locate resources for your fieldbus interface. If the default settings will
work in your system, skip to the appropriate section to install the
hardware.

To install your PCMCIA-FBUS card, skip to the Installing the
PCMCIA-FBUS Hardware section. To install your AT-FBUS board, skip
to the Installing the AT-FBUS Hardware section.

Locating Conflict-Free Resources
To locate conflict-free resources in Windows NT, you can use a utility
such as Microsoft Windows NT Diagnostics. This utility lists the I/O port
addresses, interrupt levels, and DMA channels that your system is
currently using. The resources that this utility does not list are
conflict-free; you can use them for your fieldbus interface. To use this
utility, double-click on the Windows NT Diagnostics icon in the
Administrative Tools program group.

To locate conflict-free resources in Windows 95, complete the following
steps:

1. To use the Device Manager, select Start»Settings»Control
Panel»System. Click on the Device Manager tab.



Chapter 2    Installation and Configuration

© National Instruments Corporation 2-3 NI-FBUS Monitor User Manual

2. Select the Computer and click on the Properties button. The
Computer Properties dialog box appears. You can use any
resources that do not appear in this window.

If you cannot find a free IRQ line, you can configure your fieldbus
interface to operate in polled mode, without an IRQ line. In polled mode,
NI-FBUS polls your board periodically. When you reach the Configuring
the Software section, you can configure your fieldbus interface to use
polled mode.

When you find acceptable resources, write them down, so you can
configure the hardware and software settings to match. Skip to the
Configuring the Hardware (Optional) section.

Installing the PCMCIA-FBUS Hardware
To install the PCMCIA-FBUS card, complete the following steps:

1. Shut down your operating system and power off your system.

2. Insert the card into a free PC Card (PCMCIA) socket. The card has
no jumpers or switches to set. Figure 2-1 shows how to insert the
PCMCIA-FBUS and how to connect the PCMCIA-FBUS cable and
connector to the PCMCIA-FBUS card.
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PCMCIA Socket

Portable
Computer

PCMCIA-FBUS Cable

Figure 2-1.  Inserting the PCMCIA-FBUS

3. Connect the PCMCIA-FBUS to the fieldbus network.

You kit contains one PCMCIA-FBUS cable. Refer to Appendix B,
Pinout Information, if you need to make a longer cable than the
PCMCIA-FBUS cable provided.

4. Power on your computer.

Skip to the Configuring the Software section.
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Installing the AT-FBUS Hardware

Install the AT-FBUS
To install the AT-FBUS board, complete the following steps:

1. Shut down your operating system and power off your computer.
Keep the computer plugged in so that it remains grounded while you
install the AT-FBUS board.

2. Remove the top cover or access port of the I/O channel.

3. Remove the expansion slot cover on the back panel of the computer.

4. As shown in Figure 2-2, insert the AT-FBUS board into any unused
16-bit ISA slot with the fieldbus connector sticking out of the
opening on the back panel. It might be a tight fit, but do not force the
board into place.

Figure 2-2.  Installing the AT-FBUS Board
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5. Screw the mounting bracket of the AT-FBUS board to the back
panel rail of the computer.

6. Check the installation.

7. Replace the top cover or access port to the I/O channel.

8. Connect the AT-FBUS to the fieldbus network.

If you want to make your own fieldbus cable, make sure that it uses
pins 6 and 7 for the fieldbus signals, as specified in the Fieldbus
Standard for Use in Industrial Control Systems, Part 2,
ISA-S50.02.1992. Refer to Appendix B, Pinout Information, to see
the fieldbus connector pinout of the AT-FBUS.

9. Power on your computer.

Skip to the Configuring the Software section.

Configuring the Hardware (Optional)
Follow the instructions in this section if you need to change the hardware
default settings of the AT-FBUS board. Refer to the Evaluating the
Default Settings section at the beginning of this chapter for reasons to
change the default settings of your AT-FBUS board.

Figure 2-3 shows the location of the switches, jumpers, and connector on
the AT-FBUS board.
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5 4 3

1 2

1 Product Name 3 Jumpers for IRQ 5 Assembly Number
2 Serial Number 4 Switch for Base I/O Address

Figure 2-3.  AT-FBUS Parts Locator Diagram

Selecting the Memory Base Address
The AT-FBUS board is a memory-mapped device, which means that the
driver software can use the AT-FBUS memory registers as if they were
standard memory. The memory base address of the AT-FBUS is the first
position in the total memory address space occupied by the AT-FBUS.

The AT-FBUS is configured to use memory base address D0000 hex by
default. With this setting, the board uses the memory space from D0000
hex through D4000 hex. If this address range is already used by another
device, or if you are installing more than one board, complete the
following steps to reconfigure the memory base address setting. If you
are installing more than one AT-FBUS board, each board must use a
unique memory base address. Your computer’s conventional DRAM and
all other devices cannot use the memory space you assign to the
AT-FBUS board.
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1. Choose a new memory base address.

You can configure the AT-FBUS to use lower or upper memory.
Lower memory is the memory residing in the first megabyte of
address space. Upper memory is any memory that resides above the
first megabyte. Because the AT bus can only access the first 16 MB
of address space, and the AT-FBUS must have a unique base address
in memory, you must have 8 MB or less of DRAM in your machine
to place the AT-FBUS in upper memory. If these conditions are met,
you must locate the AT-FBUS above your conventional memory and
below the 16 MB upper limit for addresses.

Table 2-2 lists the possible switch settings, the corresponding
memory base address, and the memory space used for each setting.
Bold italic denotes the default setting.

Table 2-2.  Memory Base Address Switch Settings

Switch Setting
SW1      SW2      SW3       SW4      SW5     SW6 Base Address

ON ON OFF ON ON OFF 0C0000

ON ON OFF ON OFF OFF 0C4000

ON ON OFF OFF ON OFF 0C8000

ON ON OFF OFF OFF OFF 0CC000

ON ON ON ON ON OFF 0D0000

ON ON ON ON OFF OFF 0D4000

ON ON ON OFF ON OFF 0D8000

ON ON ON OFF OFF OFF 0DC000

ON OFF OFF ON ON OFF 0E0000

ON OFF OFF ON OFF OFF 0E4000

ON OFF OFF OFF ON OFF 0E8000

ON OFF OFF OFF OFF OFF 0EC000

ON OFF ON ON ON OFF 0F0000

ON OFF ON ON OFF OFF 0F4000

ON OFF ON OFF ON OFF 0F8000

ON OFF ON OFF OFF OFF 0FC000

OFF ON OFF ON ON OFF 8C0000
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Table 2-2.  Memory Base Address Switch Settings (Continued)

Switch Setting
SW1      SW2      SW3       SW4      SW5     SW6 Base Address

OFF ON OFF ON OFF OFF 8C4000

OFF ON OFF OFF ON OFF 8C8000

OFF ON OFF OFF OFF OFF 8CC000

OFF ON ON ON ON OFF 8D0000

OFF ON ON ON OFF OFF 8D4000

OFF ON ON OFF ON OFF 8D8000

OFF ON ON OFF OFF OFF 8DC000

OFF OFF OFF ON ON OFF 8E0000

OFF OFF OFF ON OFF OFF 8E4000

OFF OFF OFF OFF ON OFF 8E8000

OFF OFF OFF OFF OFF OFF 8EC000

OFF OFF ON ON ON OFF 8F0000

OFF OFF ON ON OFF OFF 8F4000

OFF OFF ON OFF ON OFF 8F8000

OFF OFF ON OFF OFF OFF 8FC000

2. Locate the memory base address switch on your AT-FBUS board.
Refer to Figure 2-3, AT-FBUS Parts Locator Diagram.

3. Change the switch settings to configure the AT-FBUS board to the
new memory base address as shown in Table 2-2. See Figure 2-4 for
an example of the switch settings.
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O
F

F

6
4

3
2

1
5

Push this side down for (ON)

Push this side down for (OFF)

Figure 2-4.  Sample Memory Base Address Switch Setting

4. Record your new settings on the Hardware and Software
Configuration Form in the appendix, Customer Communication, for
future reference.

Selecting the Interrupt Request Line
PC AT-compatible computers have a series of interrupt lines available to
devices. Devices use interrupts to get immediate service from the CPU
for asynchronous events. Your AT-FBUS board and the NI-FBUS
Monitor software use interrupts to get service from the CPU when
necessary.

If there are no interrupt request lines available in your system, you can
configure the AT-FBUS not to use interrupts by removing the jumper
completely. If you remove the jumper, NI-FBUS periodically polls your
board.

By default, the AT-FBUS board uses interrupt request line 11. Figure 2-5
shows the setting for IRQ11.

3

W1

456791011121415

Figure 2-5.  Interrupt Jumper Setting for IRQ11
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If this is not an acceptable setting or if you are installing more than one
board, complete the following steps to reconfigure the interrupt request
line.

Note: The AT-FBUS cannot use an interrupt line that another device in your
system is already using.

1. Choose a new interrupt request line (IRQ) setting.

You can configure the AT-FBUS board to use any of the following
interrupt lines: IRQ3, 4, 5, 6, 7, 9, 10, 11, 12, 14, or 15.

If you are installing more than one AT-FBUS board, each board
must be configured to use a unique IRQ level. The AT-FBUS
requires the use of interrupts to work with your NI-FBUS Monitor
software properly.

2. Find the jumpers that set the interrupt request line. Refer to
Figure 2-3, AT-FBUS Parts Locator Diagram. The jumpers are
located on the lower edge of your AT-FBUS board. The number on
the board under each pair of pins corresponds to an AT bus interrupt
level.

3. Change the jumper settings to configure the AT-FBUS board to the
new interrupt request line. Place the jumper on the pair of pins
directly above the number of the interrupt level you want.

4. Record your new settings on the Hardware and Software
Configuration Form in the appendix, Customer Communication, for
future reference.

Go back to the Install the AT-FBUS section to install the AT-FBUS
board.

Configuring the Software
If you are installing an AT-FBUS board, the physical settings on the
board must match the software settings you configure. To read your base
address from your board switch settings, use Table 2-2. To read your
IRQ line from your board, look at the number printed on the board under
the jumper.

The configuration steps are different for Windows 95 and Windows NT.
Proceed to the appropriate section to configure the NI-FBUS software.
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Configuration Steps for Windows NT
1. Start the NI-FBUS Configuration utility.

• If you are using Windows NT 3.51, double-click on the fbconf
icon, which is part of the NI-FBUS program group, created in
your Program Manager during installation.

• If you are using Windows NT 4.0, select
Start»Programs»NI-FBUS»NI-FBUS Config.

• To use the command prompt, enter the command fbconf.exe

to start the NI-FBUS Configuration utility executable, which is
located in the utils  subdirectory of your NI-FBUS installation
directory.

2. Select Add a Board.

3. Select the correct base address.

4. Select the correct interrupt request line.

(AT-FBUS only) If you have configured your AT-FBUS not to use
interrupts, select zero from the IRQ  drop-down list, and check the
Polled Mode checkbox.

(PCMCIA-FBUS only) If you want to configure your
PCMCIA-FBUS to operate in polled mode (without interrupts),
select a valid IRQ line from the IRQ  drop-down list and check the
Polled Mode checkbox. You must enter a valid IRQ for the
PCMCIA card in polled mode because of the behavior of the
Microsoft PCMCIA driver for Windows NT. The NI-FBUS software
does not actually use an interrupt line in polled mode, but you must
still enter a valid IRQ.

5. Choose ISA or PCMCIA for the Bus Type. The NI-FBUS
Configuration utility displays the default base address and IRQ line.

6. Click on the Add button.

7. Select a port to configure and click on the Edit  button.

8. Enter an interface name for the port.

9. Select Monitor  for the Usage.

10. Click on the OK  button.

11. Close the NI-FBUS Configuration utility and restart Windows NT.

Your software is now configured. Skip to the Starting the NI-FBUS
Monitor Driver (Windows NT Only) section.
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Configuration Steps for Windows 95
Follow the steps in this section to configure your NI-FBUS software for
Windows 95.

Configuring Resources in Windows 95 (AT-FBUS
Only)
Skip this section if you are using a PCMCIA-FBUS.

In Windows 95, you must use the Add New Hardware Wizard and the
Device Manager to configure resources for your AT-FBUS.

1. To open the Add New Hardware Wizard, select
Start»Settings»Control Panel»Add New Hardware. Click on the
Next button.

2. In the dialog box that appears, select No to keep Window 95 from
trying to detect the hardware automatically, and then click on the
Next button.

3 Select Other Devices from the Hardware Types list that appears.

4. In the dialog box that appears, select National Instruments in the
Manufacturers list on the left. In the Models box, select NI-FBUS.
Click on the Next button.

5. Click on the Finish button.

6. To use the Device Manager, select Start»Settings»Control
Panel»System. Click on the Device Manager tab.

7. Select the AT-FBUS board and click on the Properties button. The
AT-FBUS Properties dialog box appears.

8. Click on the Resources tab.

9. Configure resources for your AT-FBUS board. Select a setting from
the Setting based on: list. Basic Configurations 1 and 3 do not use
an interrupt request line.

If necessary, you can change a setting in one of the Basic
Configurations by double-clicking on the setting in the Resource
settings: list. The Conflicting device list: window shows if there are
any conflicts with the resources you choose.

10. After you have selected nonconflicting resources, click on the OK
button on two successive dialog boxes to save your changes.
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Using the NI-FBUS Configuration Utility
1. Start the NI-FBUS Configuration utility.

Enter the command fbconf.exe  to start the NI-FBUS
Configuration utility executable, which is located in the utils

subdirectory of your NI-FBUS installation directory.

2. In the NI-FBUS Config window, select the port you want to
configure and click on the Edit  button.

3. Enter an interface name for the port.

4. Select Monitor  for the Usage.

5. Click on the OK  button.

Your software is configured.

Starting the NI-FBUS Monitor Driver
(Windows NT Only)

The nifb  kernel-mode driver is launched automatically under
Windows 95. Under Windows NT, you must start the nifb  kernel mode
driver manually, as follows. The installation program defines the
StartupType  for the driver as Manual .

1. After you configure your installation, restart Windows NT. You must
restart your computer before you can use the NI-FBUS software.

2. Start the kernel-mode device driver nifb  by entering the following
command at the command prompt:

net start nifb

You can also start nifb  by selecting Start»Settings»Control
Panel»System»Device Manager»NIFB»Start button.

If the process and the driver start up successfully under Windows NT,
you can configure the nifb  driver to load at system startup. Change the
StartupType  for the nifb  driver to Automatic through the Devices
window in the Control Panel. If you are using Windows NT 4.0, you can
also move the NIFB  shortcut to the StartUp folder to make it start up
automatically when your computer boots or restarts.
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Windows and Menus
3

Chapter

This chapter describes each of the menus and windows in the NI-FBUS
Monitor utility.

List of Windows
Main Window Multiple Document Interface (MDI) window that

contains all the other windows and toolbars.

Filter Window Displays data packets and statistical information.
Each filter window has its own packet filter.

Filter Dialog box you can use to select which data
packets to capture. The options are as follows:

FDL Filter— Filters packets by the Fieldbus Data
Link (FDL) layer.

FMS Filter —Filters packets by the Fieldbus
Messaging Specification (FMS)
layer.

Filter by Address—Filters packets by address.

Settings Dialog box you can use to set the following
NI-FBUS Monitor options:

Capture Settings—Capture options.

Display Settings—Color and font options.

Toolbar Settings—Toolbar options.
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Packet View Gives access to view options for the packet
Toolbar view.

Statistics View Gives access to view options for the statistics
Toolbar view.

Standard Toolbar Gives access to commonly-used functions in a
toolbar format.

About the NI-FBUS Monitor Interface
The NI-FBUS Monitor consists of windows and data objects. The main
window is the large desktop window that contains all other windows of
the NI-FBUS Monitor. It has a menu bar and various toolbars. The
smaller windows inside the main window are filter windows. Each filter
window uses a single filter to determine what data the NI-FBUS Monitor
captures. The main data object that stores these captured data packets on
a disk and holds the data in memory is called the capture document. You
can use the filter window to view the data in the capture document. You
can attach several filter windows with the corresponding filters to the
capture document.

When you select New from the File menu, the NI-FBUS Monitor creates
a new capture document and a corresponding filter window. The filter
window displays data from the capture document. Each filter window has
an exclusive filter attached to it that you can view as a dialog box.
To display the filter, select Filter Settings from the Capture menu. You
can use the filter to determine what data the NI-FBUS Monitor displays
in the filter window and what data it saves to the capture document. To
add a new filter window to the document, select New Filter Window
from the Capture menu. Adding a new filter window attaches a new
filter window and filter to the document. You can use the new filter to
filter different data.

Figure 3-1 is graphical example of the relationships between the windows
and the document. The gray area represents the graphical area that
appears on the desktop. The documents on the left are data objects
invisible on the desktop.

Note: Even if a window is split using the Split Filter Window  function, the filter
window still has only one filter attached to it.
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Figure 3-1.  Relationship of Windows to Capture Documents
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Main Window
The main window contains all the windows of the NI-FBUS Monitor.
The frame of the main window contains a menu bar and a status bar. The
frame can also have toolbars on it. Figure 3-2 shows the main window.

Figure 3-2.  Main Window

When you start the NI-FBUS Monitor, it opens a new filter window and a
new capture document. The capture document contains the actual data
packets that are captured from the bus. The filter window is a graphical
representation of the data stored in the capture document. The filter
window is minimized in Figure 3-2. By default, the NI-FBUS Monitor
opens the standard toolbar at the top and the Packet View toolbar on the
left of the main window’s frame.
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Menus and the Standard Toolbar
To see help for the NI-FBUS Monitor controls, browse through the
menus or pause the cursor over the standard toolbar, shown in Figure 3-3.
To see a short description of a menu or toolbar function, pause your
cursor over the item. The NI-FBUS Monitor displays the description in
the status bar, which is located at the very bottom of the main window.
Pause your cursor over an item in the toolbar to see a short description of
the item in a yellow rectangle near the cursor.

Standard Toolbar
Figure 3-3 shows the standard NI-FBUS Monitor toolbar.

Figure 3-3.  Standard Monitor Toolbar

Following are descriptions of the standard toolbar buttons:

New Capture Creates a new capture document.

Open Capture Opens an existing capture document.

Save Capture Saves the current capture document.

Capture Sets your capture, display, and toolbar settings.
Settings

Start Capture Starts a capture on the selected board.

Stop Capture Stops capture on the selected board.

Reset Capture Deletes all captured packets.

Live Updates Does not update the screen. Updating the screen
Off constantly can be a problem if you have a slow

computer.

Split Filter Splits the filter window into a multi-paned filter
Window window.
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Add Filter Creates a new filter window and filter for the
Window current capture document.

Filter Settings Shows the filter settings for the current filter
window.

Find Data Finds data in the current window.

Big <-> Small Enlarges or reduces the size of the toolbar
Buttons buttons.

Main Menu Bar
The main menu bar is at the top of the main window and lists all of the
operations that you can perform in the NI-FBUS Monitor. When you
select an item in the menu, a short help message describing the option
appears in the Status Bar at the bottom of the main window.

File Menu
The File menu allows you to open, save, print, and create new
documents.

Following are descriptions of the File menu selections:

New Creates a new capture document.

Open... Opens an existing capture document in *.mon

format. A text editor is included in the NI-FBUS
Monitor for opening *.txt  files.

Close Closes the current capture document.

Save Saves the current capture document. Two save
formats are allowed:  *.mon , which saves
captured and filtered data to a binary file, and
*.txt , which saves captured and filtered data as
a text file.

Save As... Saves the current capture document with a new
name.

Print... Prints the current capture document.

Print Setup... Sets up the printer and printer options.
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Recent File List the most recently saved files.

Exit Exits the NI-FBUS Monitor.

Capture Menu
The Capture menu allows you to control the capture. To view this menu,
click on the Capture option at the top of the main window, or right-click
on the filter window. The standard toolbar has a button for most of the
items in the Capture menu.

Following are descriptions of the Capture menu selections:

Settings... Sets your capture, display and toolbar settings.

Filter Settings... Shows the filter settings for the current filter
window.

Start Capture Starts a capture on the selected board.

Stop Capture Stops capture on the selected board.

Reset Capture Deletes all captured packets.

Find Data... Finds data in the current window.

Hexadecimal Data Displays hexadecimal data.

Verbose Data Displays detailed data.

High Priority Enhances live updates.
Updates

Live Updates Turns off real-time updates. This is a useful
feature if your computer is slow.

Smooth Live Shows flicker-free updates, but is slower.
Updates

Scrolling Live Scrolls data during capture, but is slower.
Updates
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View Menu
You can use the View menu instead of the toolbars to configure the
active filter window views.

Packet Menu
The Packet menu has the same options as the packet view toolbar. Refer
to the Packet View Toolbar section later in this chapter for a description
of each option.

Statistics Menu
The Statistics menu has the same options as the statistics view toolbar.
Refer to the Statistics View Toolbar section later in this chapter for a
description of each option. The Live List View  shows the devices on the
fieldbus that are active and functioning (alive).

Window Menu
You can use the Window menu to control the layout of windows
contained in the main window.

Following are descriptions of the Window menu selections:

Add Filter Window Creates a new filter window and filter for the
current document.

Split Filter Window Splits the filter window into a multi-paned filter
window.

Cascade Cascades the open windows.

Tile Tiles the open windows.

Arrange Icons Arranges the icons.

Window List List of the open windows.

Toolbars Menu
You can use the Toolbars menu to show or hide the toolbars of the
NI-FBUS Monitor.
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Following are descriptions of the Toolbars menu selections:

Standard Toolbar Shows the standard toolbar.

Packet Toolbar Shows the Packet View toolbar.

Statistics Toolbar Shows the Statistics View toolbar.

Status Bar Shows the status bar.

Help Menu
You can use the Help menu to display information about the NI-FBUS
Monitor.

Filter Window
The filter window displays the data in a capture document, and can
display this data in different formats. The filter window has three tabs
located in the bottom left of the window that you can use to switch
between statistics view and packet view. Both the statistics view and the
packet view have toolbars that allow you to choose what each view
shows. Figure 3-4 shows an example of a filter window.

Figure 3-4.  Filter Window
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Packet View
You can use the packet view to display and manipulate data packets. This
view is the main medium of interaction between you and the capture
document. To select the packet view, click on the Packets tab at the
bottom left of the filter window, or select Packet View from the View
menu. Figure 3-5 shows the filter window in packet view.

Figure 3-5.  Filter Window and Captured Data in Packet View

Packet Display Formats
Packet data can be in one of three formats:  simple, decode, or hex. All
formats have the same header, which follows:

(*/#)PACKET_NUMBER -  TIME(HH:MM:SS.US)  LENGTH -  SIZE

An asterisk (*) next to a packet indicates that a packet prior to that packet
is missing. The asterisk indicates that, after several attempts, the monitor
on the fieldbus interface could not pass the packet to the host application
(the NI-FBUS Monitor). This problem might happen on slow PCs, such
as 386 computers, but it rarely happens on 486 computers. If you see an
asterisk, read the Improving Performance section in Chapter 4, How to
Use the NI-FBUS Monitor.



Chapter 3 Windows and Menus

© National Instruments Corporation 3-11 NI-FBUS Monitor User Manual

A pound sign (#) next to a packet number means that the NI-FBUS
Monitor received the packet that arrived right before the indicated packet.

The format of the time measurement is as follows:
Hours:Minutes:Seconds.Microseconds

The Simple format is a condensed version of the Decode format, and
shows only the type of Protocol Data Units (PDUs) of the FDL, FMS,
and FAS (Fieldbus Access Sublayer) layers in the packet. The Decode
format fully decodes the data packet and formats the data according to
the PDU sections of the packet. The Hex format performs a hexadecimal
dump of the data in the PDU sections of the packet.

Packet View Toolbar
The Packet View toolbar is on the left of the main window in the
Figure 3-5. The Packet View toolbar controls how the filter window
displays data. To move the Packet View toolbar, click on it and drag it.
Pause the cursor over a toolbar control to see the tool tips. Figure 3-6
shows the Packet View toolbar.

Figure 3-6.  Packet View Toolbar

Following are descriptions of the buttons, checkboxes, and drop-down
lists on the Packet View toolbar:
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Radio Buttons

Simple Displays a short view of the data in a packet.

Decode Fully decodes the data in a packet.

Hex Displays a hexadecimal dump of the data in a
packet.

Checkboxes

FDL Displays the FDL portion of a packet.

FAS\SM FAS/SM Displays the FAS portion of a packet.

FMS FMS Displays the FMS portion of a packet.

Hex Displays decoded numeric data in hexadecimal
format. The drop-down list to the right is the
width in bytes that the data occupies on the screen.

Verbose Displays more information about the packet.

Graphic Buttons

Horizontal Displays FDL, FAS, and FMS horizontally on
Packets the screen.

Vertical Displays FDL, FAS, and FMS vertically, from
Packets top to bottom, on the screen.

Drop-Down List

Time Measured Allows you to select the time calculation to
perform on the packet. The options are as
follows:

Absolute—Shows the absolute time relative to
the start of the NI-FBUS Monitor utility.

Idle—Shows the idle time between packets.
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From Start—Shows the time from the start of
one packet to the start of the next packet.

From End—Shows the time from the end of one
packet to the end of the next packet.

Transmission—Shows the time it took to
transmit a packet.

Statistics View
The statistics view shows the volume of the types of fieldbus packets
passed over the bus, and the bus time (or bandwidth) that these packets
consume. To select this view, click on the Statistics tab at the bottom left
of the filter window, or select Statistics View from the View menu. The
most useful statistics chart is the Bandwidth chart. It is a pie chart
showing the relative use of bandwidth for the FMS, FAS, and FDL
packets as a fraction of the whole bus time. The FMS Services chart
displays the volume of the different types of services transmitted from the
FMS layers of the bus devices. The FMS Services chart is a breakdown
of the FMS PDU section of the Bandwidth chart. The FDL PDUs chart
shows the volume of the FDL PDUs transmitted over the bus. The FDL
PDUs chart is a breakdown of the FDL PDU section of the Bandwidth
chart. Figure 3-7 shows the statistics view.

Figure 3-7.  Filter Window Showing Statistics View
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Statistics View Toolbar
The Statistics View toolbar allows you to select which graphs you would
like to see. This toolbar is not visible by default. You can view this
toolbar by selecting Statistics Toolbar from the Toolbars menu.
Unchecking the box for a chart removes the corresponding chart from the
view, and checking the box for a chart displays the chart. Figure 3-8
shows the Statistics View toolbar.

Figure 3-8.  Statistics View Toolbar

Following are descriptions of the checkboxes on the Statistics View
toolbar:

Bandwidth Displays the relative bandwidth between FDL,
FAS, and FMS packets.

FMS Displays the FMS Service volume.

FDL Displays the FDL PDU volume.

Verbose Displays detailed statistics and spells out
parameter names.

Live List View
The live list view shows what devices on the fieldbus are active. This
view lists active devices as alive and inactive devices as dead. The live
list view is only active during data capture.
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Filters
The filter is a tool you can use interactively at capture time or after
capture.

Filter Operation During Capture
During capture the filter is valid, and the NI-FBUS Monitor discards all
data not matching the filter. However, if there are multiple filter
windows, the NI-FBUS Monitor checks each filter to make sure that it
retains the desired data. If you make changes to the filter, the
NI-FBUS Monitor instantly downloads the changes to the fieldbus, so the
changes take effect immediately.

Filter Operation After Capture
After capture, you can filter out more undesired data (postfilter) by
selecting only the packets you want to view. Changes to the filter forces
the NI-FBUS Monitor to refilter the data, so that only the selected
packets are visible. The NI-FBUS Monitor retains all of the original
captured data. To refilter the data and display the desired packets, click
on the packet types that you want to view again. The data filtered out
during capture is not accessible. For example, after capture, you cannot
recover Pass Token (PT) FDL packets if they were not enabled during
capture.

Basic Filter Logic
A filter behaves differently depending on whether you select addresses
on the Filter by Address tab. If no addresses are selected, the filter uses
all addresses and combines the FDL Filter  and FMS Filter  choices, and
captures the types of packets checked in those dialog boxes. If any
addresses are selected on the Filter by Address tab, incoming packets
are first screened for their address. If the address is one of the selected
addresses, it is then compared to the FDL filter and the FMS filter.
Pseudocode for the filter follows:

If no addresses are selected in the Filter by Address tab:

Packets Captured = FDL Filter + FMS Filter

If addresses are selected in the Filter by Address tab:
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Packets Captured = Address(es) * (FDL Filter + FMS Filter)

Where +  stands for or and *  stands for and.

Filter Dialog Box
To view the Filter dialog box for a filter window right-click the mouse to
bring up the Capture menu, and select Filter Settings, or you can click
on the Filter Settings toolbar button that looks like an operation

amplifier filter (  ). The title bar of a filter displays the name of the
filter window to which it is attached. The filter appears as a dialog box
with three tabs:  FDL Filter , FMS Filter , and Filter by Address. You
can open the Filter  dialog box any time before, during, and after capture,
or you can hide it from view.

The following sections describe the tabs on the Filter  dialog box.
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FDL Filter Tab
The FDL Filter  tab filters packets at the FDL layer and lists all of the
FDL PDU types for easy selection. Click on the checkbox by an FDL
type to capture that type of packet. The Show Transfer Errors checkbox
enables the display of data-transfer errors. A data-transfer error can occur
if a packet does not have the proper checksum attached to it, which can
be caused by bus noise. The NI-FBUS Monitor displays protocol errors
along with the packets. Figure 3-9 shows the FDL Filter  tab.

Figure 3-9.  FDL Filter Tab
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FMS Filter Tab
The FMS Filter  tab filters packets by FMS service and lists all the FMS
Services available. Select the FMS PDU Type using the radio buttons on
the left of the dialog box to view the services corresponding to that PDU
type in the FMS Services box. Click on a checkbox to enable capture of
the corresponding packet type. Figure 3-10 shows the FMS Filter tab.

Figure 3-10.  FMS Filter Tab
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Filter by Address Tab
The Filter by Address tab filters data for a specific address or addresses.
The NI-FBUS Monitor detects and lists all the currently detected
addresses in the Detected Addresses box of the Filter by Address tab.
The NI-FBUS Monitor captures data only for the selected addresses, and
no other addresses. If you want to capture data for all addresses, click on
the Clear All  button to ensure that no other addresses are selected. If you
want to configure the filter before capture, use the User Defined field to
insert addresses into the address list. Click on the Hex Addresses
checkbox to view the addresses in the Detected Addresses box in
hexadecimal format. The User Defined field interprets data entered as
hexadecimal data. Figure 3-11 shows the Filter by Address tab.

Figure 3-11.  Filter by Address Tab

Settings Dialog Box
This dialog box contains optional settings for capturing data, displaying
data, and changing the toolbar. To bring up the Settings dialog box,
select Settings from the Capture menu.
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Capture Settings Tab
The Capture Settings tab allows you to select the board to use, and to
specify what you want the NI-FBUS Monitor to do after it receives the
number of packets in the Max num of packets field. Figure 3-12 shows
the Capture Settings tab.

Figure 3-12.  Capture Settings Tab

Following are descriptions of the options on the Capture Settings tab:

Bus Name Allows you to select a fieldbus interface board.

Max num of Allows you to enter the maximum number of
packets packets you want the NI-FBUS Monitor to

capture.

Stop capture when Stops capture of data after the NI-FBUS Monitor
max reached receives the Max num of packets.

Continuous Continues capture after the NI-FBUS Monitor
capture when receives the Max num of packets by dumping
max reached the oldest packet from the captured data, and

saving the newest packet.
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Stop on packet Stops continuous capture when a packet error
decoding error occurs. Improper packet decoding format causes
(SW) decoding errors.

Stop  packet Stops continuous capture when a reception error
reception error occurs.
(HW)

Write to file Writes captured data directly to the file specified
in the field. If you select Continuous capture
when max reached, the NI-FBUS Monitor
writes data to the file until you stop the capture.
During a continuous capture, the number of
packets retained in memory does not exceed the
value in the Max num of packets field.

Display Settings Tab
The Display Settings tab allows you to select the colors of packet
portions and the font the NI-FBUS Monitor uses to display data. To
change a color, click on the color next to the field name. To change the
font, click on the Fonts... button. To reset the colors and fonts to the
NI-FBUS Monitor defaults, click on the Default Colors and Default
Font buttons. Figure 3-13 shows the Display Settings tab.

Figure 3-13.  Display Settings Tab
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Toolbar Settings Tab
The Toolbar Settings tab allows you to select which toolbars the
NI-FBUS Monitor displays. Click on the Big Buttons checkbox to
enlarge the standard toolbar buttons. Click on the Show Tool Tips
checkbox to activate the tool tip help for most controls. To view the tips,
pause your cursor over a control. Figure 3-14 shows the Toolbar
Settings tab.

Figure 3-14.  Toolbar Settings Tab
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How to Use the
NI-FBUS Monitor

4
Chapter

This chapter describes how to perform basic tasks with the NI-FBUS
Monitor.

Starting the NI-FBUS Monitor
To launch the NI-FBUS Monitor application, double-click on the
Fieldbus Monitor icon in the Fieldbus Software program group.

Starting Capture
To start capture, complete the following steps:

1. (Optional) Before starting a capture, you might want to open the
filter to select specific packets to capture. To open the filter, select
Filter Settings from the Capture menu or click on the Filter
Settings button (  ) on the standard toolbar. The filter appears as a
dialog box that allows you to select which packets you want to
capture. You do not have to configure the filter at the start of
capture; you can configure the filter any time during the capture.

2. (Optional) To select a board to capture from, select
Capture»Settings... and select the Capture Settings tab from the
Settings dialog box.

3. To capture data, select Start Capture from the Capture menu or
click on the Start Capture button on the standard toolbar.
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Stopping Capture
You can stop data capture in one of two ways:

• Select Stop Capture from the Capture menu or click on the Stop
Capture button (  ) on the standard toolbar.

• Select Capture»Settings... and click on the Capture Settings tab in
the Settings dialog box. Click on the Stop capture when max
reached button to stop capture after the NI-FBUS Monitor receives
the number of packets specified by Max num of packets.

Saving Data
To save the captured data, select Save from the File menu or click on the
Save Capture button (  ) on the standard toolbar. The NI-FBUS
Monitor places the saved data in the current window. During the save
operation, the NI-FBUS Monitor prompts you to save all of the captured
data or just the filtered data, if there was any filtering after capture.

You can save data in two formats:

• *.mon , a binary format that the NI-FBUS Monitor can reload and
refilter.

• *.txt , an ASCII format that text editors can load.

Finding Data
To find data, select Find Data... from the Capture menu or click on the
Find Data button (  ) on the standard toolbar. The Find dialog box, as
shown in Figure 4-1, appears. If the NI-FBUS Monitor finds the data, it
places an elliptical mark by the packet in which the data appears.
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Figure 4-1.  Find Dialog Box

Viewing Data
You can view data in a filter window, and switch between tabs to view all
the information, or you can split the window and view all tabs at once.

To split the current Filter window into four panes, select Window»Split
Filter Window  or click on the Split Filter Window  button (  ) on the
standard toolbar. The split window allows you to look at different parts of
the capture at the same time. Figure 4-2 shows an example Filter window
screen split into four panes that display the data for this filter.

Figure 4-2.  Example Filter Window Session
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In Figure 4-2, the upper left pane displays statistical information about
the packets on the bus, and the other three panes display the packets in
the simple, decode, and hex modes, respectively. The toolbar affects the
currently active view, so be sure to select a view by clicking in the view
area before selecting the toolbar options.

Improving Performance
This section contains hints for improving the performance of the
NI-FBUS Monitor on systems slower than the platform recommended
mentioned in the Recommended Minimum Platform section of Chapter 1,
Introduction.

Conserve Memory
Close unnecessary applications, and set Max num of packets on the
Capture Settings tab to a low value (less than 500). To see the Capture
Settings tab, select Capture»Settings... or click on the Capture Settings
button on the standard toolbar.

Turn Live Updates Off
To prevent the NI-FBUS Monitor from updating its windows, deselect
Live Updates on the Capture menu. On a slow computer, it can take a
relatively long time (more than one second) to update the graphics in
windows. During this time, you can lose many data packets. Lost packets
are denoted by an asterisk (* ) before the packet in the capture.

Filter Only for Needed Data
Pass Token (PT), Time Distribution (TD), Return Token (RT), Probe
Node (PN), Probe Response (PR), and Compel Data (CD) packets occur
frequently. You might not want to collect all of these, particularly the
Probe Node (PN) packets.

No Split Windows
In general, the fewer open windows the NI-FBUS Monitor has to update,
the faster the NI-FBUS Monitor performs.
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Hardware Specifications
A

Appendix

This appendix describes the electrical, physical, and environmental
characteristics of the AT-FBUS and PCMCIA-FBUS hardware and the
recommended operating conditions.

Table A-1.  Electrical Characteristic for the AT-FBUS

Characteristic Specification

Power Requirement 750 mA Typical

Table A-2.  Physical Characteristics for the AT-FBUS

Characteristic Specification

Dimensions 10.7 by 19.1 cm
(4.2 by 7.5 in.)

I/O Connector DB-9 DSUB (1 per Fieldbus
Channel)

Table A-3.  Environmental Characteristics for the AT-FBUS

Characteristic Specification

Operating Environment:

   Component Temperature
   Relative Humidity

0° to 70° C
10% to 90%, Noncondensing

Storage Environment:

   Temperature
   Relative Humidity

-40° to 125° C
5% to 90% Noncondensing

EMI FCC Class B Verified
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Table A-4.  Electrical Characteristic for the PCMCIA-FBUS

Characteristic Specification

Power Requirement 500 mA Typical

Table A-5.  Physical Characteristics for the PCMCIA-FBUS

Characteristic Specification

Dimensions 85.6 by 54.0 by 5.0 mm
(3.4 by 2.1 by 0.4 in.)

I/O Connector Cable with DB-9 DSUB and
5-Position Screw Terminal
(1 per Fieldbus Channel)

Table A-6.  Environmental Characteristics for the PCMCIA-FBUS

Characteristic Specification

Operating Environment:

   Component Temperature
   Relative Humidity

0° to 70° C
10% to 90% Noncondensing

Storage Environment:

   Temperature
   Relative Humidity

-40° to 125° C
5% to 90% Noncondensing

EMI FCC Class A Verified
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Pinout Information
B

Appendix

This appendix contains information about the pinout of the fieldbus
connectors.

One cable for either the PCMCIA-FBUS or AT-FBUS is included in your
kit. The following figures show the pinout of the fieldbus connectors so
you can make your own cable if you need a longer cable than the one in
your kit.

Figure B-1 shows the fieldbus connector pinout for both the AT-FBUS
and PCMCIA-FBUS.

1
2

3
4

5

6
7

8
9

No Connection

No Connection

 No Connection

No Connection

No Connection

Power -

Power +

Data - 

Data +

Figure B-1.  Fieldbus Connector Pinout

The pinout of the fieldbus connector uses pins 6 and 7 of the J1 connector
for the fieldbus signals, as specified in the Fieldbus Standard for Use in
Industrial Control Systems, Part 2, ISA-S50.02.1992.
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Figure B-2 shows the PCMCIA-FBUS cable. An arrow on the cable
points to pin 1 of the screw terminal block.

J2

J1

PCMCIA-FBUS, PORT 1

V-
D-

SH
D+

V+

Figure B-2.  PCMCIA-FBUS Cable

Figure B-3 shows J2, the screw terminal block pinout for the
PCMCIA-FBUS cable.

1
2
3
4
5

 Power -
 Data -
 Shield
 Data +
 Power +

Figure B-3.  Screw Terminal Block Pinout

All of the signals on the screw terminal block provide a direct connection
to the 9-pin DSUB. Pins 2 and 4 of the J2 screw terminal block provide
an alternate connection to the fieldbus. The screw terminal block is not a
second, independent link. National Instruments provides the Power+ and
Power- connections as passive connections from the DSUB to the screw
terminal. The PCMCIA-FBUS itself does not supply power to or draw
power from these pins.
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Customer Communication
C

Appendix

For your convenience, this appendix contains forms to help you gather the information necessary to
help us solve technical problems and a form you can use to comment on the product documentation.
When you contact us, we need the information on the Technical Support Form and the configuration
form, if your manual contains one, about your system configuration to answer your questions as
quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
quickly provide the information you need. Our electronic services include a bulletin board service,
an FTP site, a Fax-on-Demand system, and e-mail support. If you have a hardware or software
problem, first try the electronic support systems. If the information available on these systems does
not answer your questions, we offer fax and telephone support through our technical support
centers, which are staffed by application engineers.

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded instructions on
how to use the bulletin board and FTP services and for BBS automated information, call
(512) 795-6990. You can access these services at:

United States:  (512) 794-5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.



Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone at
(512) 418-1111.

E-Mail Support  (currently U.S. only)
You can submit technical support questions to the applications engineering team through e-mail at
the Internet address listed below. Remember to include your name, address, and phone number so
we can contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country, contact
the source from which you purchased your software to obtain support.

Telephone Fax

Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 527 2321 09 502 2930
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 5734815 03 5734816
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
U.K. 01635 523545 01635 523154



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our applications
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ____  ) _________________________ Phone ( ___  ) ___________________________

Computer brand ___________________ Model _____________ Processor ________________

Operating system (include version number) ____________________________________________

Clock Speed _________ MHz RAM __________ MB Display adapter________________

Mouse _____yes ____ no Other adapters installed _____________________________

Hard disk capacity ________  MB Brand ___________________________________________

Instruments used _________________________________________________________________

National Instruments hardware product model _____________________ Revision ___________

Configuration ___________________________________________________________________

National Instruments software product ____________________________ Version ___________

Configuration ___________________________________________________________________

The problem is __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps will reproduce the problem _________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item.
Complete a new copy of this form each time you revise your software or hardware configuration,
and use this form as a reference for your current configuration. Completing this form accurately
before contacting National Instruments for technical support helps our applications engineers answer
your questions more efficiently.

National Instruments Products
Model and Revision of FBUS Hardware________________________________________________

Interrupt Level of Hardware  ________________________________________________________

Base I/O Address of Hardware  ______________________________________________________

NI-FBUS Monitor Software Version  __________________________________________________

Other Products
Computer Make and Model  _________________________________________________________

Microprocessor  __________________________________________________________________

Clock Frequency  _________________________________________________________________

Type of Video Board Installed  ______________________________________________________

Operating System  ________________________________________________________________

Operating System Version  __________________________________________________________

Operating System Mode  ___________________________________________________________

Programming Language  ___________________________________________________________

Programming Language Version  _____________________________________________________

Other Boards in System  ____________________________________________________________

Base I/O Address of Other Boards  ___________________________________________________

DMA Channels of Other Boards  _____________________________________________________

Interrupt Level of Other Boards  _____________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products.
This information helps us provide quality products to meet your needs.

Title: NI-FBUS Monitor User Manual

Edition Date: March 1997

Part Number: 321018B-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Phone ( _____ ) ________________________  Fax ( ____  ) __________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678
Austin, TX 78730-5039
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Glossary

Prefix Meaning Value

n- nano- 10-9

µ- micro- 10-6

m- milli- 10-3

M- mega- 106

A

alive Active and functioning on the fieldbus.

ASCII American Standard Code for Information Interchange.

asynchronous Communication that occurs at times which are not predetermined.

AT-compatible Compatible with the 16-bit Industry Standard Architecture.

B

B Bytes.

bandwidth The capacity of a bus to transmit data.

binary format A file format composed of ones and zeroes for computer use.

bus A pathway for data between devices.
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bus noise Imperfections in data transfer caused by cable length or interference from
external factors.

C

capture document An NI-FBUS monitor document in memory that contains all the settings
and data of your capture.

CD Compel Data.

channel A pin or wire lead to which you apply or from which you read the analog
or digital signal.

checksum A method used to ensure that data is transmitted correctly.

Communication Stack The hierarchy of layers in a layered communications model that performs
the services required to interface the User Application to the Physical
Layer of the fieldbus.

CPU Central processing unit.

D

data packet A unit of data of a certain size.

dead Inactive or not functioning on the fieldbus.

DMA Direct Memory Access.

DRAM Dynamic Random Access Memory. Memory that requires electricity and
refreshing to hold data.

F

FAS See Fieldbus Access Sublayer.

FDL See Fieldbus Data Link layer.

fieldbus An all-digital, two-way communication system that connects control
systems to instrumentation.
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Fieldbus Access The layer of the communication stack that provides an interface between
Sublayer the DLL and layer 7 of the OSI model. The FAS provides communication

services such as client/server, publisher/subscriber and event distribution.

fieldbus address Location of a board or device on the fieldbus; the fieldbus node address.

Fieldbus Data Link The second lowest layer of the fieldbus communications stack.
layer

Fieldbus Messaging The layer of the communication stack that defines a model for
Specification layer applications to interact over the fieldbus. The services FMS provides

allow you to read and write information about the OD, read and write the
data variables described in the OD, and perform other activities such as
uploading/downloading data, and invoking programs inside a device.

filter A software screening device you configure to make the NI-FBUS
Monitor capture only certain types of data that move across the fieldbus.

Filter window A window inside the main window of the NI-FBUS Monitor that shows
captured data with selected data filtered out.

FMS See Fieldbus Messaging Specification layer.

H

hex Hexadecimal.

Hz Hertz.

I

I/O Input/output.

IRQ Interrupt request.

ISA Industry Standard Architecture.

L

layer See Communication Stack.
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M

MDI See Multiple Document Interface.

Multiple Document A software interface that contains many smaller windows open
Interface concurrently that display data from different sources.

P

PC Personal Computer.

PDU Protocol Data Unit

PN Probe Node.

PR Probe Response.

processor The central controlling and computing part of a computer.

protocol error An error in data transfer that has to do with the way the data is sent.

PT Pass Token

R

RAM Random Access Memory

RT Return Token.

T

TD Time Distribution.
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Index

A
adding filters. See filters, adding
address

selecting. See base memory address,
selecting

switch settings. See memory base
address, switch settings

asterisk (*) next to a packet, 3-10

B
bandwidth. See data, statistics
Bus Name field, 3-20

C
cables, B-1
capture

deleting captured packets, 3-5, 3-7
resetting, 3-5, 3-7
starting, 3-5, 3-7, 4-1
stopping, 3-5, 3-7, 4-2

capture document, 3-2
closing, 3-6
new, 3-5, 3-6
opening, 3-5, 3-6
opening a recent document, 3-7
printing, 3-6
saving, 3-5, 3-6

capture document
renaming, 3-6
Save As.... See capture document,

renaming
capture settings, 3-1, 3-5, 3-20
changes taking effect, 3-15
closing a capture document. See capture

document, closing
colors

changing, 3-21
configuring

hardware. See hardware, configuring
software. See software, configuring

conventions, xii
creating a new capture document. See capture

document, new

D
data

decode format, 3-11, 3-12
detailed format, 3-7, 3-12
displaying, 3-12
FAS/SM portions of packets, 3-12
FDL portions of packets, 3-12
filtering, 3-16
finding, 3-6, 3-7, 4-2
FMS portions of packets, 3-12
formats, 3-10
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hexadecimal format, 3-7, 3-11, 3-12
saving, 4-2
simple format, 3-11, 3-12
statistics, 3-13
viewing, 4-3

decode format. See data, decode format
default settings, 2-2
detailed data. See data, displaying
display settings, 3-1, 3-21
displaying data. See data, displaying
documentation comment form, C-5
documents to read for more information, xiii

E
e-mail support, C-2
exiting the NI-FBUS Monitor, 3-7

F
fax support, C-2
FAS/SM portions of packets. See data,

FAS/SM portions of packets
FDL filter. See filters, FDL
FDL portions of packets. See data, FDL

portions of packets
fieldbus

related documentation, xiii
filter

Filter Settings menu item, 3-7
filter dialog box, 3-16
filter logic, 3-15
filter operation after capture, 3-15
filter operation during capture, 3-15
filter window. See window, filter
filtering by address. See filters, by address
filters, 3-2, 3-15

adding, 3-6, 3-8
by address, 3-19
by the FDL layer, 3-1

by the FMS layer, 3-1
FDL, 3-17
filter settings, 3-16
how filters work. See filter logic
number of filters attached to a filter

window, 3-2
viewing settings

finding data. See data, finding
FMS filter. See filters, FMS
FMS portions of packets. See data, FMS

portions of packets
fonts

changing, 3-21
format of data. See data, formats
format of packet data. See data, formats
format of time information, 3-11
FTP support, C-1

H
hardware

configuring, 2-6
installing, 2-2

hardware specifications, A-1
help

tooltips, 3-5
hexadecimal data. See data, hexadecimal

format
hexadecimal format. See data, hexadecimal

format

I
icons

arranging, 3-8
installing

hardware. See hardware, installing
software. See software, installing

interrupt request line
sample jumper setting (picture), 2-10
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selecting, 2-10
IRQ. See interrupt request line

K
kernel-mode device driver, 2-14

L
learning more about fieldbus, xiii

M
making your own cable, B-1
Max num of packets field, 3-20
memory base address

sample switch setting (picture), 2-10
selecting, 2-7
switch settings, 2-8

menus
Capture, 3-7
File, 3-6
Help, 3-9
Packet, 3-8
Statistics,3- 8
Toolbars, 3-8
View, 3-8
Window, 3-8

N
new capture document

creating. See capture document, new
nifb process. See NI-FBUS process
NI-FBUS Monitor, 1-1
NI-FBUS process, 2-14
nonconflicting resources

locating. See resources, locating

O
opening a capture document. See capture

document, opening
opening a recent capture document. See

capture document, opening a recent
document

organization
of this manual, xi

P
packet types shown

FDL, 3-17, 3-18
FMS, 3-18

Packet View (picture), 3-10
packets transmitted over the fieldbus

types of packets. See data, statistics
performance

improving, 3-5, 3-7, 4-4
pinout information, B-1
platform

recommended minimum, 1-2
postfilter. See filter operation after capture
pound sign (#) next to a packet, 3-11
Print Setup, 3-6
printer options. See Print Setup...
printing. See capture document, printing

Q
quitting the NI-FBUS Monitor. See exiting

the NI-FBUS Monitor

R
refreshing. See screen refreshing
resetting capture. See capture, resetting
resources

locating, 2-2
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S
Save As.... See capture document, renaming
saving a capture document. See capture

document, saving
saving data. See data, saving
screen refreshing

enhancing, 3-7
scrolling, 3-7
smoothing, 3-7
turning off, 3-5, 3-7

screen updating. See screen refreshing
searching. See data, finding
selecting the interrupt request line. See

interrupt request line, selecting
selecting the memory base address. See

memory base address, selecting
settings dialog box, 3-1, 3-19
Settings menu item, 3-7
simple format. See data, simple format
software

configuring, 2-11
configuring for AT-FBUS, 2-11
installing, 2-1

specifications. See hardware specifications
splitting a filter window. See windows,

splitting
starting capture. See capture, starting
starting the NI-FBUS Monitor, 4-1
static electricity, 2-1
Statistics View (picture), 3-13
status bar, 3-9
stopping capture. See capture, stopping
support. See technical support
switch settings

memory base address. See memory base
address, switch settings

T
technical support, C-1

technical support form, C-3
telephone support, C-2
time calculation, 3-12
tool tips, 3-22
toolbar

enlarging, 3-6
shrinking,3-6

toolbar settings, 3-1
toolbars

Packet, 3-9
packet view, 3-2, 3-11
Packet View (picture), 3-11
settings, 3-22. See toolbar settings
showing, 3-9
standard, 3-5
Statistics, 3-9
statistics view, 3-2, 3-14
Statistics View (picture), 3-14

V
viewing data. See data, formats and data,

viewing
viewing filters. See filters, viewing
views

live list, 3-14
packet, 3-10
statistics, 3-13

W
windows

adding filter windows, 3-2, 3-6, 3-8
cascading, 3-8
configuring, 3-8
filter, 1-1, 3-1, 3-2, 3-9
filter (picture), 3-9
list of open windows, 3-8
Main, 3-1, 3-4
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relationship of windows to capture
documents, 3-3

splitting, 3-2, 3-5, 3-8
tiling, 3-8

Write to file field, 3-21
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